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1. OVERVIEW 

The 7780TSM line of remote probes is a complete embedded hardware based solution for compressed 
network monitoring. By monitoring the MPEG Transport Stream at strategic points within the distribution 
network, in conjunction with the industry leading VistaLINK® PRO NMS (Network Management System), 
the 7780TSM offers service providers the tools to continuously and effectively have the confidence that 
their MPEG-2/H.264 signals within any IPTV, Satellite, terrestrial or cable network are being delivered 
properly. 
 
The 7780TSM supports the two most popular interfaces ASI or IP. With support for over 400Mb/s (on 
ASI), 200Mb/s (on IP) of total MPEG-2/H.264 traffic on a single 7780TSM, these probes can, for 
example, separate encoder errors from network delivery errors allowing the operator to act quickly and 
avoid down time. 
 
The industry leading Evertz VistaLINK® PRO NMS offers a new dimension to TS monitoring by allowing 
a graphical customization of any measurement performed and a quick viewing of the different points in 
the system. It makes the 7780TSM probe system a valuable system in any operational environment. 
 
Features: 

• 1 IP input  
• IGMP subscription and IP layer monitoring including MDI 
• Transport Stream analysis: 

o Presence, Bitrate analysis, table rate analysis 
o TR101290 Level 1, level 2*, and partial level 3 

• Complete TS and PID bitrate measurement from 100kb/s to 200Mb/s with settable limits 
• Display of Transport Stream tree 
• Display of video resolution, audio type, etc. 
• Matching of PID assignment with pre-defined PID list and TSID verification 
• Only PCR accuracy and PCR repetition rate supported at this time. No jitter measurement 
• Up to 5 hot-swappable 7780TSM modules per chassis 
• Fully Integrated with the Industry leading Evertz VistaLINK®  PRO NMS 
• Auto-Response Scripting Capability 
• Comparing of the same stream at different locations in the network 
• SNMP Enabled (control and alarms for monitoring) 
• Complete customization of status view and error report in VistaLINK® PRO 
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Figure 1-1: 7780TSM-IP Block Diagram 

2. INSTALLATION OF 7780TSM-IP 

To successfully install the 7780TSM-IP you will need the following: 
 

1. Unused IP address on the network or a DHCP server 
2. Evertz serial cable - supplied 
3. VLPro Server IP address 
4. Data network IP address 

 

 

Note: The 7780TSM-IP does not require a Frame Controller in the chassis.  Only 
connect the cables to the rear plate when the basic configuration has been 
completed. 

 

2.1. HARDWARE INSTALLATION 

Before handling the card it is important to minimize the potential effects of static electricity. It is 
therefore recommended that an ESD strap be worn. 
 
Locate on a 7700 chassis two adjacent vacant slots. Unpack the 7780TSM-IP and separate the rear 
card from the main card. Locate on the rear of the rack the two slots and remove the blanking panels. 
Insert the rear card into the back of the chassis and secure using the four screws provided.  
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Before inserting the front card, connect the serial cable to the board using the serial cable provided. 
Now insert the 7780TSM-IP card into the corresponding front slots ensuring the card lines up with the 
slot runners on the bottom and the top of the chassis. Push the card into the slot ensuring that when it 
mates with the rear card that has been firmly pushed into a seated position. This can be confirmed 
when the connectivity lights for the Ethernet port are illuminated. Do not connect any cables to the rear 
card (failure to do this could cause unwanted network issues) until the initial configuration has been 
completed. 
 

 
 
Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal 
session and configure the port for the following configuration: 
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Figure 2-1: COM Properties Window 

 
 

Bits per second 115200 
Data Bits 8 
Parity None 
Stop Bits 2 
Flow Control None 

 
Click OK to apply these settings and press return. The session should respond with the 7780TSM-IP 
Main Menu as shown in Figure 2-2:  
 

 
Figure 2-2: HyperTerminal Main Menu 
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(1) Network Configuration 
This sub-menu enables the user to configure the network settings for the card. 
 
(2) SNMP Configuration 
This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this 
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community 
strings. 
 
(3) Setup Transport Stream Receivers 
This sub-menu is used to configure the Transport Stream Receivers. As this configuration can also be 
performed via VLPro this sub-menu will not be described in this section. 
 
(4) Utilities 
This sub-menu contains two utilities. One command is for clearing the memory, and the other for 
clearing the flash. In normal operation it should not be necessary to use either of these options. 
 
(5) Engineering/Debug 
This menu is for Evertz personnel only. You may be requested to access and execute options within 
this menu when seeking technical support from Evertz. Guidance will be given should this be required. 
 
Before is it possible to configure the card via VLPro it is first necessary to configure the initial basic 
network settings via the serial cable, this is covered in the next section. 
 

2.2. CONFIGURING THE BASIC NETWORK SETTINGS 

From the terminal session window select option (1) Network Configuration, the Network Configuration 
menu will be displayed as shown in Figure 2-3. If you prefer to use DHCP then you may select option 
(5) Use DHCP, and then continue from step 4: 
 

1. Select option (1) Set IP Address and configure the IP address for the 7780TSM-IP ensuring that 
the IP address is not already in use on the network.  

2. Now select option (2) Set Netmask and configure the correct subnet mask for your network.  
3. If required also configure option (3) Set Gateway.  
4. Exit from the Network Configuration menu using (S) Save and Exit, NOT (X) Exit. 
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Figure 2-3: Network Configuration Sub-Menu 

 
From the Main Menu select option (2) SNMP Configuration. Normally it is only necessary to configure 
here. Under option (1), Set Trap IP Address, enter here the IP address of your VLPro Server.  Exit 
using option (S) Save and Exit option, now extract the card from the rack, remove the serial cable, and 
re-insert it. 
 
You have now completed the necessary minimum configuration and can connect the cables to the rear 
card when ready. 
 

2.3. CONNECTING TO VLPRO 

This chapter assumes that the VLPro server and VLPro client are already configured for your network 
and you have basic knowledge of the VLPro interface. It also assumes that the user or network 
administrator has already added the 7780TSM-IP jar file to the server and both the client and server 
applications have been restarted. If you are the network administrator refer to section 6.2 for 
information on updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+”. Your 
7780TSM-IP should appear as a newly listed device with the IP address used to configure the card in 
Step 1 above. It may take up to a minute to appear while the card and switch negotiate network 
settings (this can be verified directly on the switch if necessary). 
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Figure 2-4: VistaLINK® PRO Hardware Configuration 

 

 

Note: If after a couple of minutes the card has still not appeared try selecting 
Add Agent from the Tree> Add/Update Agent menu. Enter the IP address used 
in the configuration stage earlier and select OK.  The card should now be listed 
and will remain grayed out for a moment while VLPro finds the card and 
confirms its configuration. 

 
Please consult your network administrator if you continue to have problems connecting the card with 
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
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3.  CARD CONFIGURATION 

3.1. INPUT STATUS 

Right-click the IP address of the 7780TSM-IP to access the sub-menu. Select View Configuration. The 
right window will display the 7780TSM-IP Configuration page as shown in Figure 3-1. 
 

 
Figure 3-1: VistaLINK® PRO Input Status Tab 

 
The Input Status page will open in the right window of VLPro.  Here we can confirm that the correct 
board has been selected from the tree and that the board is loaded with the correct firmware in the 
Card Type box. Below that is the status of the fifty inputs. The status of the inputs will not change 
unless a valid IP feed is detected in the IP stream and the input is properly configured; you might need 
to refresh the status or select auto-refresh to see them change. Using the auto refresh button can aid 
troubleshooting of connectivity issues although it will prevent any configuration changes. 
 
There are no user configurable items on this page because it is for information only. 
 



7780TSM-IP 
Transport Stream Monitor 

 

CONFIGURING INPUTS Revision 1.0 7780TSM-IP - 13 

3.2. OUTPUT CONTROL 

The output control tab provides four output destinations control boxes. Each requires a destination IP 
address, the destination port number and selection of the input stream to be re-routed. The Selected 
Program box allows the user to define their entry to aid easy identification. 
 
The four outputs can be used to re-route any of the fifty monitored streams to another destination, 
which is a useful feature for further monitoring of the feeds or more in depth analysis. 
 

 
 

Figure 3-2: VistaLINK® PRO Output Control Tab 
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3.3. CONFIGURATION 

The configuration tab is used to configure the data network settings. Here up to five individual Vlans 
can be configured. For each of the fifty inputs the vlan can be selected simply by knowing the vlan 
number as referenced on this configuration page.  

 

 
 

Figure 3-3: VistaLINK® PRO Configuration Tab 
 

3.3.1. Data Port Configuration 
The configuration sub-window refers to the physical data port of the 7780TSM-IP card. An IP address 
must be provided for the network along with the subnet mask. This establishes a presence on the data 
network. Depending upon your network configuration you may not have an address allocated for this, in 
this case leave the IP address as 0.0.0.0. 
 

3.3.2. Vlan Configuration  
The vlan configuration requires, for each vlan, a valid unused IP address, the subnet mask and vlan ID. 
You may optionally add, in the vlan name entry box, a familiar or reference vlan name.  Repeat the 
configuration for as many vlans as required up to the maximum of five. 
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3.4. NETWORK STATISTICS 

The Network Statistics tab displays the network statistics for the two individual gigabit Ethernet 
interfaces on the back plate. The upper port, as viewed from the back of the chassis, is the 
Management Port (Control) and the other is the data port. The data port is used to connect the data 
network for monitoring of the IP streams using the IP address entered on the Configuration tab. 
 

 
Figure 3-4: VistaLINK® PRO Network Statistics Tab 

 
The network statistics can be reset at any time by selecting the “Clear Network Stats” drop down box, 
as shown below, and selecting the “Clear” option. Once the setting is applied, using the apply button, 
the statistics will be reset and begin to count from zero again. 
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4. SPECIFICATIONS 

4.1. GENERAL FEATURES 

• 1 IP Input (50 multicasts) 
• 5 Vlans 
• IGMP subscription and IP Layer monitoring including MDI 
• MPEG/DVB/ATSC Transport Stream Monitoring (TR 101 290) P1, P2 (No jitter measurement) 

and P3 
• Complete TS and PID bitrate measurement from 100Kb/s to 200Mb/s with settable limits 
• Display of Transport Stream contents 
• Display of video resolution, audio type, etc 
• 4 Multicast stream redirects 
• Multicast stream redirect for decoding or detailed analysis of remote stream 
• Up to 7 hot-swappable 7780TSM modules per chassis 
• SNMP Enabled (control and alarms for monitoring) 
• Complete customization of status view and error report in VistaLINK® PRO 

 

4.2. MONITORED PARAMETERS 

• IP Measurements 
• MDI-Media Delivery Index DF: MLR (Delay Factor: Media Loss Rate) 
• RTP Statistics 

 

4.3. MONITORED PARAMETERS TR 101 290 P1 

1.1 TS_sync_loss 
1.2 Sync_byte_error 
1.3 Pat_error 
1.4 Continuity_count_error 
1.5 PMT_error 
1.6 1.6 PID_error 
 

4.4. MONITORED PARAMETERS TR 101 290 P2 

2.1 Transport_error 
2.2 CRC_error 
2.3a PCR_repetition_error 
2.4b PCR_error 
2.4 PCR_accuracy error 
2.5 PTS_error 
2.6 CAT_error 

4.5. TABLES AND REPETITION 

DVB SI repetition error (NIT, SDT, EIT, RST, TDT) 
ATSC PSIP tables repetition error (MGT, TVCT, CVCT, EIT, RRT, STT) 
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4.6. INPUTS AND OUTPUTS 

1xRJ45 input 10/100/1000 with 200Mb/s of MPEG over IP traffic (50 multicasts) 
1xRJ45 input 10/100/1000 control port 
 

5. CONFIGURING INPUTS 

With the 7780TSM-IP hardware tree expanded, it is possible to see the sub components, in this case 
Input 1 through to Input 50. By right clicking and selecting configure, it is possible to configure each of 
the inputs completely independently of each other. The section below outlines the use and meaning of 
each of the tabs and any user configurable entries. 
 

5.1. BITRATE VIEW TAB 

The Bitrate View tab is where VLPro displays the standard Transport Stream parameters. As shown 
below it is possible to see all the packets within the TS stream, organized in ascending order by 
Service ID.  It is possible to reverse the ordering or select another column to re-sort the data. This can 
be done by double clicking the column header, making sure you are not in the auto refresh mode when 
doing this. 
 
For each individual PID it is possible to view the minimum and maximum Bitrate since the last reset. By 
configuring the minimum and maximum threshold it is possible to configure the desired thresholds for 
notifying the user through VLPro. The Bitrate View is a dynamic view; by clicking the auto refresh it is 
possible to see near instantaneous values for the stream. 
 

 
Figure 5-1: VistaLINK® PRO Bitrate View Tab 
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5.2. INPUT CONFIGURATION TAB 

This tab is used to select the stream type being monitored and input basic configuration information for 
the stream. The additional information is used to further enhance the transport stream diagnostics and 
alarming capabilities of the card. 
 

 
Figure 5-2: VistaLINK® PRO Input Configuration Tab 

 

5.2.1. Input Parameters 

• Input Name: Where the stream can be given an easily identifiable, user configurable name.  
  
• Input Mode: Options available are ATSC, DVB and MPEG.  

o It is important to select the standard to which the stream is being coded as this affects 
the context of the alarms for ETSI TR 101 290 priority 3. 

 
• Transport Stream ID expected: Enter the value for the Transport Stream ID expected, enter 

zero to disable the test. 
 
• Number of PIDs expected:  Enter here the number of PIDs expected in the stream (including 

the null packets if any), enter zero to disable the test. 
 
• PID Display Mode: Options available are Decimal or Hex.  
 
• TS ID Display Mode: Options available are Decimal or Hex  

 

 
Note: It is not possible to enter the TS ID as a Hex value. 
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• Min Bitrate: Enter a decimal value corresponding to the absolute lowest bitrate expected for 
the whole stream; an alarm condition will be caused if the stream rate should drop below this 
value. 

 
• Max Bitrate: Enter a decimal value corresponding to the highest bitrate expected for the whole 

stream; an alarm condition will be caused if the stream rate should exceed this value. 
 

5.2.2. Misc Control Entry 

• Clear Monitoring: Selecting the clear option and applying it will clear the recorded statistics for 
the Max and Min bitrates as well as reset the error counts for all Priority 1, 2 and 3 Syntax 
Errors. 

 

5.2.3. Input Control 

• Monitor Enable: Using this drop-down box it is possible to enable or disable individual inputs 
to stop alarm generation. This stops all alarms from the 7780-TSM being sent to the VLPro 
Server. 

 
• Destination IP address: Enter here the destination IP address, the multicast address you want 

the TSM to monitor. Ensure you enter the correct IP address and it is in the multicast address 
range of 224.0.0.0 through 239.255.255.255. 

 
• Port Number: Enter here the destination port number for the IP address entered above.  
 
• Vlan select: Use this drop down box to select the vlan, configured from the main configuration 

tab earlier, which contains the stream to be monitored. If you are not using vlans leave this set 
to “no vlan”. 
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5.3. INPUT MONITOR TAB 

The Input Monitor Tab provides the user with an overview of the input status. 
 

 
Figure 5-3: VistaLINK® PRO Input Monitor Tab 

 

5.3.1.  Input Monitor 

• Input State: Either active or inactive. 
 
• Num Programs: This is the number of programs found in the input stream. 
 
• Num PIDS: This is the total number of individual PIDs found in the stream. 

o Includes all ghost PIDs and Null packets. 
 

• Input Bitrate: This is the current bitrate of the input ASI stream. 
 
• Transport Stream ID: The decimal value for the input stream. 

o For example: Corresponds to one satellite transponder. 
 

• Network ID: The decimal value for Transport Stream Network ID. 
o For example: Corresponds to one entire satellite of transponders. 
 

• Network Name: If available the network name will be displayed. 
 
• Num Packets/IP: Displays the number of MPEG packets per IP packet. 

 
• Packet Framing: Displays the type of framing being used, either UDP or TCP. 
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5.3.2. MDI Monitor 

• Delay Factor: The Delay Factor is the maximum difference measured between the arrival of 
each packet over a one second period. The value shown is measured in milliseconds and 
represents the delay factor in the last second. 

 
• Media Loss Rate (packets/s): Displays the media loss rate. This is defined as the number of 

lost or out-of-order media packets per second. This is measured using the continuity count in 
the MPEG header. 

 
• Delay Factor Max: Displays the Max delay factor since the last reset. The delay factor that is 

acceptable for any particular network varies greatly because of the wide range of buffer sizes 
used in STBs. 

 
• Media Loss Rate Max: Displays the max Media Loss Rate since the last reset.  Loss of media 

can cause distorted video and audio. Each lost IP packets can mean as many as seven MPEG 
packets being lost. Loss of consecutive IP packets will affect the media more severely. 

 
• Ideal Delay Factor: Displays, in milliseconds, a calculated value representing the ideal delay 

factor, which depends on the stream bitrate and the available bandwidth of the network (Up to 
200Mb/s for the TSM). 

 
• Delay Factor Threshold (ms): A user definable value in milliseconds. When this value is 

exceeded an SNMP trap will be sent to VLPro providing notification that the stream has 
exceeded the preset Delay Factor Threshold value. 

 
• Media Loss Rate Threshold: A user definable value in milliseconds. When this value is 

exceeded an SNMP trap will be sent to VLPro providing notification that the stream has 
exceeded the preset Media Loss Rate Threshold value. 

 

5.3.3. Error Monitor 

• Input Status: A system message to notify the user if the input is valid ASI. 
 
• Syntax Error Status: A system message to notify the user if any of the ETSI TR 101 290 

P1/P2/P3 monitoring tests are currently in an alarm condition.  The tests which have been 
checked (Fault Monitor) are displayed here. The determination of the severity can be selected 
on the syntax tabs. 

 
• Template Error Status: A system message to notify the user if the TS input does not comply 

with the template parameters entered in the Input Configuration Window TS.  
 

• IP Layer Status: A system message that displays the current status of the IP Layer. If an IP 
address and port number have been correctly entered and the stream is available this will 
display IP Layer OK. 
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5.3.4. Syntax Errors – P1 & P2 
This tab displays a general health check of the most important elements of the TS. The tests are 
not exhaustive and are outlined in detail in the document Digital Video Broadcasting (DVB); 
Measurement guidelines for DVB systems ETSI TR 101 290. It should be noted that the P3 errors 
are context sensitive to the type of input stream selected (under Input Configuration). 

 

 
Figure 5-4: VistaLINK® PRO TS Syntax Errors – P1 & P2 Tab 

 
For each test there is a Fault Monitor check box. Selecting this check box will update the Input 
Configuration Tab Syntax Error status. The highest alarm severity will prevail. When selecting the 
checkbox be sure to select, from the drop down box, the severity that is associated with this alarm. 
Even when the check box is not selected the relevant SNMP trap will be triggered for the test unless 
disabled from the Fault Control tab, the check box only updates the Syntax Error Status. 
 

5.3.5. P1 Necessary for Decoding 

• TS_sync_loss:  The most important function for the evaluation of data from the MPEG-2 TS is 
the sync acquisition. The actual synchronization of the TS depends on the number of correct 
sync bytes necessary for the device to synchronize; two or more consecutive corrupted sync 
bytes indicate sync loss. After synchronization has been achieved the evaluation of the other 
parameters is carried out. 

 
• Sync_byte_error:  The indicator "Sync_byte_error" is set as soon as the correct sync byte 

(0x47) does not appear after 188 or 204 bytes. This is fundamental because this structure is 
used throughout the channel encoder and decoder chains for synchronization. It is also 
important that every sync byte is checked for correctness since encoders do not necessarily 
check the sync byte.   
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• PAT_error: The Program Association Table (PAT), which only appears in PID 0x0000 packets, 
tells the decoder what programs are in the TS and points to the Program Map Tables (PMT) 
which in turn point to the component video, audio and data streams that make up the program. 
If the PAT is missing then the decoder can do nothing, no program is decodable. Nothing other 
than a PAT should be contained in a PID 0x0000. 

 
• Continuity_count_error:  For this indicator three checks are combined. The preconditions 

"Incorrect packet order" and "Lost packet" could cause problems for receivers that are not 
equipped with additional buffer storage and intelligence. It is not necessary for the test 
equipment to distinguish between these two preconditions as they are logically OR-ed, together 
with the third precondition, "a packet occurs more than twice" into one indicator.  

 
• PMT_error: The Program Association Table (PAT) tells the decoder how many programs there 

are in the stream and points to the PMTs that contain the information where the parts for any 
given event can be found. Parts in this context are the video stream (normally one) and the 
audio streams and the data stream (e.g. Teletext). Without a PMT the corresponding program is 
not decodable. 

 
• PID_error:  It is checked whether there exists a data stream for each PID that occur. This error 

often occurs where TS are multiplexed, or demultiplexed and again remultiplexed.  
 

5.3.6. P2 Recommended 

• Transport_error:  The primary Transport_error indicator is Boolean which counts the erroneous 
TS packets. This counter is intended for statistical evaluation of the errors. If an error occurs, no 
further error indication should be derived from the erroneous packet.  

 
• CRC_error:  The CRC check for the CAT, PAT, PMT, NIT, EIT, BAT, SDT and TOT indicates 

whether the content of the corresponding table is corrupted. In this case no further error 
indication should be derived from the content of the corresponding table. 

 
• PCR_error:  The PCRs are used to re-generate the local 27 MHz system clock. If the PCR 

does not arrive with sufficient regularity then this clock may jitter or drift. PCR discontinuity of 
more than 100 ms occurring without specific indication or the time interval between two 
consecutive PCR values is more than 40 ms. 

 
• PCR_repetition_error: The PCRs are used to re-generate the local 27 MHz system clock. If 

the PCR do not arrive with sufficient regularity then this clock may jitter or drift. The 
receiver/decoder may even go out of lock. This error indicates that the time interval between two 
consecutive PCR values is more than 40 ms. 

 
• PCR_discontinuity_indicator_error: The PCR_discontinuity_indicator_error is set in the case 

that a discontinuity of the PCR values occurs that has not been signalled appropriately by the 
discontinuity indicator.  

 
• PCR_accuracy_error: The accuracy of ±500 ns is intended to be sufficient for the colour 

subcarrier to be synthesized from the system clock. This test should only be performed on a 
constant bitrate TS as defined in ISO/IEC 13818-1. 

 
• PTS_error: The Presentation Time Stamps (PTS) should occur at least every 700 ms. The PTS 

is only accessible if the TS is not scrambled. 
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• CAT_error:  The CAT is the pointer to enable the receiver to find the EMMs associated with the 
CA system(s) that it uses. If the CAT is not present, the receiver is not able to receive 
management messages. 

 

5.4. TS SYNTAX ERRORS - P3 

 
Figure 5-5: VistaLINK® PRO TS Syntax Errors - P3 

 

5.4.1. P3 DVB Tables 

• NIT_Repetition_error: This test checks that any two sections with table_id = 0x40 (NIT_actual) 
occur on PID 0x0010 within a 25 ms. 

 
• NIT_error: Network Information Tables (NITs) as defined by DVB contain information on 

frequency, code rates, modulation, and polarization etc. of various programs that the decoder 
can use. It is checked whether NITs are present in the TS and whether they have the correct 
PID. The test checks that sections with table_id 0x40 or 0x41 in PID value 0x0010 occur at least 
every 10 s. 

 
• Unreferenced_PID: Each non-private program data stream should have its PID listed in the 

PMTs. This test detects the presence of a PID (other than PAT, CAT, CAT_PIDs, PMT_PIDs, 
NIT_PID, SDT_PID, TDT_PID, EIT_PID, RST_PID, reserved_for_future_use PIDs, or PIDs user 
defined as private data streams) not referred to by a PMT within 0.5 s. 

 
• SI_repetition_error: For SI tables a maximum and minimum periodicity are specified in EN 300 

468 [7] and TR 101 211 [8]. This indicator should be set in addition to other indicators of 
repetition errors for specific tables. 
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• SDT_error:  The SDT describes the services available to the viewer. It is split into sub-tables 
containing details of the contents of the current TS (mandatory) and other TS (optional). Without 
the SDT, the IRD is unable to give the viewer a list of what services are available. It is also 
possible to transmit a BAT on the same PID, which groups services into "bouquets". 

 
• SDT_Repetition_error: This test checks that the SDT information which describes the services 

contained in a particular Transport Stream is transmitted at least every 2 seconds on PID 
0x0011. 

 
• EIT_error:  The EIT (Event Information Table) describes what is on now and next on each 

service, and optionally details the complete programming schedule. The EIT is divided into 
several sub-tables, with only the "present and following" information for the current TS being 
mandatory. The EIT schedule information is only accessible if the TS is not scrambled. 

 
• RST_Repetition_error:  This test checks that any two sections with table_id = 0x71 (RST) 

occur on PID 0x0013 within 25 ms (or lower). 
 

• RST_error: The RST is a quick updating mechanism for the status information carried in the 
EIT. 

 
• TDT_Repetition_error: This test checks that any two sections with table_id = 0x70 (TDT) occur 

on PID 0x0014 within 25 ms. 
 

• TDT_error: Sections with table_id = 0x70 (TDT) not present on PID 0x0014 for more than 30 s. 
The TDT carries the current UTC time and date information.  

 
More information can be found at: http://www.etsi.org/ 
 

5.4.2. P3 ATSC Tables 

• MGT Repetition: Master Guide Table. For each type of PSIP tables, the MGT provides the 
location in the Transport stream, the current version of the table and the length in bytes. This 
test checks that the Master Guide Table repetition rates do not exceed 150ms. 

 
• TVCT Repetition: Terrestrial Virtual Channel Table. Consists of virtual channel definitions 

where each channel is characterized by the two-part channel number that the user will use to 
access the service, its text name, how the service is physically delivered, its MPEG-2 
program_number, its “source ID” and the type of service. This test checks that the Terrestrial 
Virtual Channel Table repetition rates do not exceed 400ms. 

 
• CVCT Repetition: Cable Virtual Channel Table. Consists of virtual channel definitions where 

each channel is characterized by the two-part channel number that the user will use to access 
the service, its text name, how the service is physically delivered, its MPEG-2 program_number, 
its “source ID” and the type of service. This test checks that the Cable Virtual Channel Table 
repetition rates do not exceed 400ms. 

 
• EIT Repetition: The PSIP table that carries program schedule information for each virtual 

channel, this test checks the following is true: 
o EIT-0 Once every 0.5 seconds 
o EIT-1 Once every three seconds 
o EIT-2 and EIT-3 Once every minute 
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• RRT Repetition: Rating Region Table. Defines a rating system for a given region characterized 
by a number of rating dimensions, each of which is composed of two or more rating levels. This 
test checks that the Rating Region Table repetition rates do not exceed 60,000ms. 

 
• STT Repetition: System Time Table. Provides a reference for the time-of-day to receivers. This 

test checks that the System Time Table repetition rates do not exceed 1000ms.  
 
More information can be found at: http://www.atsc.org 
 

5.4.3. ETSI TR 101 290 Test Conditions 
The status LED located to the left of each test will highlight, when in Auto-Refresh the dynamic status 
of the stream. 
 
For the majority of the ETSI TR 101 290 test it is possible to configure custom configurations to ensure 
that particular alarms and conditions are fed back to the operator. It is important to select the Monitor 
Enable check box (to enable custom monitoring parameters to be invoked), select the desired alarm 
Severity and then configure the test Threshold.  
 

 
NOTE: Syntax Errors P1, P2 & P3 are measured in ms. PCR Errors are measured 
in ns. 

 

5.5. TR 101 290 DVB REFERENCE VALUES 

Test DVB  
TS_sync_loss   
Sync_byte_error   
PAT_error 500ms  
Continuity_count_error   
PMT_error 500ms  
PID_error 500ms  
Transport_error   
CRC_error   
PCR_repetition_error 40ms  
PCR_error 100ms  
PTS_error 700ms  
CAT_error   
 

5.6. FAULT CONTROL 

The fault control tab is a user configurable tab for enabling or disabling the fault conditions that can be 
triggered by the standard ETSI TR 101 290 checks discussed in the previous chapter. 
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Figure 5-6: VistaLINK® PRO Fault Control Tab 

 
The four window sub-sections allows users to custom configure which ETSI TR 101 290 test conditions 
can trigger an alarm: 
 
Within this tab it is possible to individually de-select (all are selected by default) or re-select which tests 
can produce an alarm condition. The following subsections correspond with the previous two tabs: 

• P1 Necessary for Decoding 
• P2 Recommended 
• P3 DVB Tables 
• P3 ATSC Tables 

 
It is important to ensure new settings are applied using the apply button on the menu. 
 

 

DVB/ATSC tests may be greyed out depending on which mode has been selected 
under the Input Configuration Tab (DVB/ATSC or MPEG). ATSC mode will disable 
DVB; DVB mode will disable ATSC and MPEG will disable both ATSC and DVB. 

 

5.7. TRIGGER FAULTS TAB 

The Trigger Control tab provides a user configurable custom configuration for the top-level alarm 
statuses. This can be used to provide quick visual overviews of the ETSI TR 101 290 test status. An 
operator would need to refer either to the TS Syntax Error Tabs and review the status LED’s, or to the 
alarm log to identify the test condition(s), which have triggered the alarm (status red). 
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Figure 5-7: VistaLINK® PRO Trigger Faults Tab 

 
The two window subsections, Trigger Fault Enable and Trigger Fault Status, permits the user to 
customize the top-level alarms. By de-selecting, all levels are checked by default.   
 
In the third window subsection there is a single fault called Ts Bitrate Enable. This relates to the second 
Tab (Input Configuration) and provides a summary alarm for the status of the maximum and minimum 
bitrates that were configured. No alarm would therefore imply that all PIDs are within the configured 
bandwidth limits defined by the user.  
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6.  TROUBLESHOOTING 

6.1. VLPRO DOES NOT DISPLAY THE 7780TSM-IP ALARMS 

Refer to section 1 to connect directly to the board via the serial port. Once a connection has been 
establish, check and/or configure the SNMP settings with the correct VLPro Server IP address and 
ensure the community strings are correctly set. Refer to the network administrator if you are in doubt as 
to what these should be set to. 

 

6.2. UPDATING VLPRO SERVER JAR FILE  

Products from Evertz are constantly evolving and new features are often added. It is therefore 
important to update the JAR files in use to provide access to all the latest features or enhancements. It 
will also be necessary to add JAR files for new products. If your new product has not appeared even 
after waiting a few minutes for the Ethernet switch negotiation to complete then it is possible that your 
JAR file may be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro 
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.  

 

 
Figure 6-1: VistaLINK® PRO Server  

 
A window will appear, as shown below, simply navigate to the location of the new JAR file and select 
the file by double clicking. The window will automatically close and the update will be applied in the 
background.  
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Figure 6-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
 

Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the startup to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay 
while the update is applied. A prompt will appear confirming that the updates have been applied.
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7. ABBREVIATIONS 

For the purposes of the present document, the following abbreviations apply: 
 
BAT Bouquet Association Table 
BER  Bit Error Rate 
BW  BandWidth 
CA  Conditional Access 
CAT Conditional Access Table 
CPE Common Phase Error 
CRC  Cyclic Redundancy Check 
ETSI European Telecommunications Standards Institute 
DC  Direct Current 
DVB  Digital Video Broadcasting 
DVB-C  Digital Video Broadcasting baseline system for digital cable television (EN 300 429 [6]) 
DVB-CS  Digital Video Broadcasting baseline system for SMATV distribution systems (EN 300 473 

[13]) 
DVB-S  Digital Video Broadcasting baseline system for digital satellite television (EN 300 421 [5]) 
DVB-T  Digital Video Broadcasting baseline system for digital terrestrial television (EN 300 744 

[9]) 
EIT  Event Information Table 
ETR  ETSI Technical Report 
ETS  European Telecommunication Standard 
FEC  Forward Error Correction 
HEX  Hexadecimal 
ISO  International Organization for Standardization 
ITU  International Telecommunication Union 
MGT Master Guide Table 
MPEG  Moving Picture Experts Group 
NIT  Network Information Table 
PAT  Program Association Table 
PCR  Program Clock Reference 
PID  Packet Identifier 
PMT Program Map Table 
PSI  MPEG-2 Program Specific Information (as defined in ISO/IEC 13818-1 [1]) 
PSIP Program and System Information Protocol 
PTS  Presentation Time Stamps 
RS  Reed-Solomon 
RST  Running Status Table (see EN 300 468 [7]) 
RTE Residual Target Error 
SDT  Service Description Table 
SI  Service Information 
TDT  Time and Date Table 
TOT  Time Offset Table 
TS  Transport Stream 
UTC  Universal Time Co-ordinated 
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